
 1 

 
 

 

 

 

 
 

 

 

Getting Started User’s Guide 

 

 

 

 

 
 

 

 

 

 

 
 

 

 

 

 

 
 

 

If you need assistance … 

Technical Support: 

Monday through Friday 

9:00 a.m. to 5:00 p.m. Eastern Time 

E-mail: support@lawgic.com 
Phone: toll free 877-2-LAWGIC (252-9442) or 904-223-2223 

Fax: 904-223-2224 

www.lawgic.com 

mailto:support@lawgic.com
http://www.lawgic.com/
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Chapter 1:  About This Guide and Getting Started 

 

This user’s manual will guide you through the creation of a document using the Lawgic 

software. It is a summary of the more extensive System Help within the Lawgic 

software available by selecting Help on the Lawgic menu and then Help again.  
 

If after reading this guide and creating a document you have further questions, we 

provide a number of additional resources as described in the ‘Getting Help in Using the 

Software’ section below.   

 

Conventions Used in This Guide 

 
 Menu or button commands will be given in Bold Face (Example: “Click the Start 

button.”) 

 Important information on how to use the program is indicated by a symbol. 

 A note will be indicated by a symbol. 
 

Getting Help in Using the Software 

 
To help you get the most out of your Lawgic subscription, we provide the following 

tools in addition to this manual: 

 

Private Product Training: We highly recommend you schedule a free one-on-one 

web based training to get you started with the program. Simply click HERE and choose 
‘Private training’.  

 

Webinar Training: We offer multiple training topics via Webinar. Simply click HERE 

and sign up for any of these free training webinars. 

 

Product Training Videos: We highly recommend you review the Product Training 

videos available on our web site at www.lawgic.com.  Click the Support link and then 
the Training link where you can DOWNLOAD the file to your computer.  The videos 

are also available on CD by request. 

 

General System Help is available from within the Lawgic product by clicking Help on 

the Lawgic menu and then Help again.  This displays a table of contents on the left 

side of the screen that enables you to quickly access the help topics you need. Scroll 
to and click the appropriate category or topic. This action will display either the text of 

an explanation or a list of subordinate help topics, one or more of which may provide 

the information you need. 

 

 

http://www.lawgic.com/calendar.html
http://www.lawgic.com/calendar.html
http://www.lawgic.com/
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Important!   In order to ensure proper document formatting 

and before creating your first document, we highly 

recommend you review the Editing Your Documents topics for 

Word or WordPerfect available in System Help by clicking Help 
on the Lawgic menu inside the program and then Help again. 

 

Title-specific Help Resources is available by clicking Resources on the Help menu 

bar.  This displays a list of various primary source and supporting materials that relate 

to your specific product(s). These Resource materials include: 

 
 Getting Started Guide 

 Update Letters 

 Product Outline 

 Key court decisions 

 Relevant statutes and regulations 

 
The program allows you to quickly view the text of these Resources and, if you wish, 

to print them. All of these Resources can be searched electronically.   

 

Estate planning products only:  ‘How To’ Help is available by selecting ‘How To’ 

from Question 1 (Select An Activity).  It includes numerous topics, such as how to 

create various trusts on death, how to customize documents and how to create 

templates. 
 

In addition to general system Help and title-specific Help Resources, you can also click 

About Our Authors on the Help menu to display biographies of the authors of the 

program Titles.  Also, click License Agreement on the Help menu to display the 

License Agreement of the program. 

 
You can also access a list of Frequently Asked Questions (FAQs) by selecting 

Support and then Frequently Asked Questions from our web site at 

www.lawgic.com.  

 

Contacting Technical Support 

 
 Telephone: You can call our Technical Support staff toll free at 877-2-LAWGIC 

(252-9442) or 1-904-223-2223 Monday through Friday 9:00 a.m. – 5:00 p.m. 

Eastern Time. (You may leave voice mail if you call at other hours.) 
 

 Fax: 1-904-223-2224 Address your fax to "Technical Support." 

 

 Mailing Address: 

 

Lawgic LLC 
Technical Support Department 

4475 Sutton Park Ct. 

Suite 404 

Jacksonville, Florida 32224 

http://www.lawgic.com/
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 Email: Our email address is support@lawgic.com.  We encourage the use of email 

especially if you have a more substantive legal, estate planning or program 

question as this will help expedite your answer. 
 

 Lawgic's Web Site: Visit our home page at http://www.lawgic.com/. 

 

Whether you fax, e-mail, or write to us, please include your name, day or evening 

phone numbers, the best time to return your call, and your e-mail address, if 

available. 

mailto:support@lawgic.com
http://www.lawgic.com/
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Chapter 2:  Getting Started 

 

 

Please refer to the installation document provided as part of your subscription.   

Installation instructions were emailed to you with your order confirmation. 
 

1. To begin, click Start, click All apps, select the Lawgic program group, and then 

click Lawgic. (on Older systems click All Programs) 

 

The Select Title/File dialog box is displayed (see Figure 2-1). 

 

 
Figure 2-1: 

Select Title/File 

dialog box 

  

 

 

  

  

 

 

 New begins a new answer file in the Title you select. 

 Files lets you open one of your previously saved answer files. 
 Templates loads a “template,” which is an answer file you can create for 

reusable scenarios. The advantages of templates are explained in Chapter 9: 

Creating Templates. 

 

 

Important!   Answers are saved in an answer file.  Typically 

you create one answer file per client.  The program creates 
multiple documents from one answer file.  Your answers are 

shared across all documents, which decreases errors and 

ensures consistency. 

 

2. To begin answering questions, click New at the Select Title/File box, which begins 

a new answer file, not a document.  
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Important!  If you are using the  Colorado, Michigan, South 

Carolina or Tennessee titles, the following box will appear:  

 

 

 

Figure 2-2: Open 

Template dialog 
box 

  

 

 
 

  

  

Choose your state template and click ‘ok’. 

 

 

 

3. This will take you to the Title page for that Title (see Figure 2-3).  The Title Page 
displays the name of the product’s author. 

 

 

 

Figure 

2-3: Title 

Page 

  

 

 

  

  

 

 

 

4. Click the Start button to go to Question 1 (see Figure 2-4).  This screen displays a 

list of the activities available in the Title.  Select the activity you want to perform.  

Each document option is created separately. 



 9 

 

 

Figure 2-4: 

Question 1 – 
Select An Activity 

  

 

 

  

  

 

 

5. Click the Continue button.  (You can also press Ctrl+Down 

Arrow on your keyboard.)     
 

 

Important!   The Continue button takes you to the next 

unanswered, relevant question based on your prior answers.  

It is the only way to proceed through the questions in order to 

create a document. 

 

6. This takes you to a sub-menu relating to your answer choice at Question 1.  (See 
Figure 2-5).  Make your selection and click the Continue button. 

 

Figure 2-5: 

Trusts Menu 

  

 

 

  

 

 

Important!   The program will always re-present the 

Title Page, Question 1 and any sub-menu relating to 

your choice at Question 1 whenever you open the 
answer file or when you return to it from the word 

processor.  Simply click the Continue button to proceed. 
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7. Before you go any further be sure to save your answers by selecting Save or Save 

As from the File menu. The Save As function allows you to also enter a 
Description.  See Chapter 5: Saving Your Answer Files for more detailed 

information. 

 

 

8. To finish creating your first document, simply click the Continue button and 

answer all of the questions presented until you see the ‘All Questions Answered’ 
screen (Figure 2-6 below) at the end of the Q & A process.  (See the following 

Chapters 3-8 for details on how to navigate, review and save your answers). 

 

 

Figure 2-6: All 

Questions 
Answered dialog 

box 

  

 

 

  

  

 

 

 
9. At the ‘All Questions Answered’ screen, select ‘Send to Word Processor.’  The 

program will create and name the document and then send it to your word 

processor where you can make edits.  You must then name and save the document 

in your word processor.  (See Chapter 7, Creating Your Document). 
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Chapter 3:  Understanding the Program Window 

Layout 

 

 

The program window is divided into 3 sub-windows (see Figure 3-1): 

 

 The Navigator Window appears along the left side of the screen.  This window 

displays an outline of the Title, indicating which questions will be or have been 
asked. A red checkmark indicates that you have already provided an answer for 

that question. 

 

 The Question Window is located at the top right section of the screen. This 

window displays the full text of the current question and your answer. 

 
 The Folders Window (with tabs that display different views), located at the 

bottom right hand side of the screen.  Clicking on the various tabs allows you to 

view either Progress (dynamic text based on your answers), Law & Strategy 

relating to the current question, Notes that you may record about the current 

question, Question Help on how to answer the current question, or Scratch Pad 

to enter the various names that will be used throughout the file. 
 

 

Figure 

3-1: The 

Program 

Window 

Showing 
the 

Separate 

Sub-

windows 

  

 

 

  

  

 

Each window can be resized by dragging the border.  Move your mouse over the 

border until a double-headed arrow appears, then hold down the left mouse button 

and drag the border to the desired position. 
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The Navigator Window 
 

The Navigator Window (Figure 3-2) is located on the left side of the screen. This 

window displays an outline of the Title.  When expanded it will show which questions 

have been asked and answered. A red checkmark indicates that you have already 
provided an answer for that question.  A gray checkmark means the question has 

been suppressed based on previous answers not allowing the question to be included.  

See Chapter 8, Navigating and Reviewing Your Answers for additional information on 

the Navigator. 

 

 

Figure 3-2: The 
Navigator 

window 
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Elements in the Navigator can be used to help determine your progress through the 

Title: 

 

  

A checkmark indicates that you have already answered the question. If 

there is no checkmark, you have not yet answered the question or the 

question is not applicable to what you are working on. 

 

 

Click the Plus Sign to expand a section of the Navigator and view an 

outline of questions contained in that section. 

 

  Click the Minus Sign to collapse a section of the Navigator's outline. 

 

 

Bold 

  

 If a question appears in blue bold, you have previously flagged this 

 question for later use. 

 

Highlighted  The current question appears highlighted in the Navigator. 

Italics  If a question appears in italics, you have marked it tentative. 

Red 

  

 If a question appears in red, its answer is required before the  

 intended question can be presented. 

 

Green 
 If a question appears in green text, it contains notes in the Notes  
 folder. 

Gray 

  

 If a question appears grayed out, it is suppressed and not relevant  

 based on answers you've provided. 

 

 

Important!   Some questions require that certain threshold 

questions first be answered. For example, to answer questions 
about minor children, you must specify that the couple has 

such children. This is called a threshold question. If you try to 

bypass a threshold question using the Navigator, the program 

will automatically jump to the threshold question.  When this 

happens, the threshold question appears in red on the 

Navigator. 
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The Question Window 
 

The Question Window (Figure 3-3) is located in the top right section of the screen. 

This window displays the full text of the current question, relevant choices (if any), 

and your answer. 
 

 

Figure 3-3: The 

Question window 

  

 

 

  

  

 

 

 
 

Here’s a quick overview of the elements in the Question Window: 

 

 

 

 
 

 

Flag this question to bold it in the Navigator by clicking the 

Flag icon in the bottom left of the Question Window.  

When clicked, the Flag icon changes color to red. Flags are 

not saved when you exit the file.  To save the flagged 

questions for future reference select Save Flags from the 
Flag menu.  Then, name and save the flags.  Flags are used 

extensively with Templates. 

 

 
 

 

Mark this question tentative by clicking the Tentative icon in 

the bottom left of the Question Window.   At the end of 
the Q&A process, a ‘Tentative Answers’ box will pop up to 

remind you that you have tentative answers. 

 

 

Takes you back to the last question you viewed. 
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Takes you to the next relevant unanswered question. If you 

are creating a new document use this mode to go forward 
through the questions.  To go back through questions you 

have already answered use the ‘Review’ mode (see below). 

 

 

Takes you to the next relevant question, whether or not it 

has already been answered. This is very useful in changing 
answers in completed files. 

 

To toggle between Continue and Review, click the arrow to 

the right of the Continue/Review button and select the 
desired mode. 

 

 

 
 

The Folders Window 
 

The Folders Window contains five folders that display different types of information 

to help you as you proceed through the questions and answer session.  If a folder’s 

tab does not have a red check mark, the current question does not contain that type 

of information. 
 

Progress Folder 
Clicking the Progress tab in the Folders Window opens the Progress Folder, which 

shows dynamic text based on your answers (see Figure 3-4).   

 

 

 
Figure 

3-4: 

Progress 

Folder 

  

 

   

 

 

As you proceed through the questions, the program will build a document based on 

your answers. The Progress Folder allows you to read the text of the section, clause, 
or document that is affected by your answer to the current question. 

 

Law & Strategy Folder 
Clicking the Law & Strategy tab in the Folders Window opens the Law & Strategy 

Folder, which displays the federal and state legal analysis of a question written by the 

Title’s authors. (See Figure 3-5).   
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Figure 

3-5: 

Law & 

Strategy 
Folder 

  

 

 

  

  

 

This analysis, which may vary depending on your facts, addresses issues such as: 

 

 Statutes, regulations, or court decisions that could affect your answer 

 Legal ramifications of alternative approaches 

 Relevant practice considerations 

 

 

Notes Folder 
Clicking the Notes tab in the Folders Window will open the Notes Folder (Figure 3-

6).  Here, you can record any observations you think relevant to a particular question. 

If you have already written notes for the current question, clicking the Notes tab will 

display them. These comments can be edited or deleted at any time. Notes are not 

reflected in the document generated by the program. 
 

 

Figure 

3-6: 

Notes 

Folder 

  

 

 

  

  

When Notes Are Helpful... 

 

 When you are uncertain about a particular question and need to record your 

concerns. 

 When you are handing off your work to a colleague and want to bring his or her 
attention to particular issues. 

 When you are creating a template and want to record your insights on why you 

drafted the template the way you did. 

 

To print Notes, click the File menu, select Send and click Notes; the Notes will now 

be displayed in your word processor.  From here you can print as you would normally.  

See Chapter 6: Recording and Sharing Your Thoughts for more information on Notes. 
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Question Help Folder 
Click the Question Help tab in the Folders Window to display context-sensitive help 

relating to that question (Figure 3-7). 

 
Figure 3-

7: 

Question 

Help 

folder 

  

 

 

  

  

 

Question Help answers the following types of questions: 
 

 Why is this question being asked? What are the ramifications of alternate answers? 

 What background information or factual context is relevant to answering the 

question? 

 How does the question relate to other questions? 

 What decision making, drafting issues, or definitions are relevant? 

 
 

 

Important!  We highly recommend you read Question Help the 

first few times through the software as it contains important 

information not found elsewhere.  We receive many tech support 

calls with questions whose answers are explained in the Question 

Help folder.  
 

 

Scratch Pad Folder 

Clicking the Scratch Pad tab in the Folders Window opens the Scratch Pad 

Folder. This folder allows you enter all relevant names for a client file in a single 

location and then simply right click on the appropriate name and insert it from the 
scratch pad as needed.  (See Figure 3-8).  Please refer to Help in the Lawgic software 

for further explanation. 

 
Figure 

3-8: 

Scratch 

Pad 
folder 

  

 

 
  

  

http://www.lawgic.com/Help/System/BRJCD.htm
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Chapter 4:  Answering Questions: The Intelligent 
Dialogue 

 

 

During a question-and-answer session, the expert author of your Title is always 
present. Think of this as a dialogue with an expert attorney. Following are some of the 

benefits of this electronic dialogue.  

 

Instead of making you wade through a morass of potentially irrelevant questions, this 

program makes an ongoing evaluation of each answer you provide. With each answer, 

the software is assessing the next question's relevance, and modifying its phrasing, its 

available choices, and its related legal commentary. If you go back and change any 
answers, all answers are reevaluated and the question and answer stream may be 

dynamically modified. 

 

For example, in the estate planning products if you answer ‘no’ to the question: Is 

Your Client Married?, the program will ignore questions relating to creating a marital 

trust and only ask relevant ones. If you subsequently change your answer to "yes,” 
you will be returned to the questions relating to the marital trust.  

 

With a click of the mouse, the expert will provide you several types of important 

information, including legal analysis and practical advice relating to the current 

question. In addition, as you answer questions, the software simultaneously builds 

your document. Clicking the Progress tab in the Folders Window will display the 

section of the document currently being built.  
 

Question Types 
 

Single-select or multi-select questions allow either a single selection or multiple 

selections, depending on the specific question.  In a selection question where you may 

make only a single choice, use the mouse to click a new choice. A new selection 

automatically clears the old. In a selection question where multiple choices are 
possible, use the mouse to click an existing choice to clear it, or click a new choice to 

select it.  Alternatively, for both question types, you may use the up and down arrow 

keys on your keyboard to move the focus to the desired choice, and then press the 

space bar to select it. 

 

Fill-in Questions are questions that require you to type in a response.  These 

questions provide a text field, and the cursor is automatically placed in this field. Type 
the appropriate information.  Alternately, you can copy and paste text from another 

source into the screen. 

 

Providing Dates: Whenever you are prompted to provide a specific date, enter the 

information using any standard date format, but be sure to specify the year using four 

digits; for example:  8/9/1999, 04-17-1957, etc. 
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Answering with a Blank: There may be occasions where you lack certain 

information (e.g., a birth date).  To insert a blank, click Set to Blank on the 

Answers menu. You can also insert a blank by leaving the answer empty on screen 

and clicking the Continue button. 
 

Review Questions: At the end of each major section in the program you will have 

the opportunity to preview the text that has been created for that entire section (see 

Figure 4-1).  To activate this feature you need to answer ‘Yes’ to the “Include Article 

Reviews?” question that is presented at the beginning of the program. 

 
 

Figure 4-1: 

Review 

Question  

 

  

 

 

  
  

 

 

The <*> symbols in the Progress window are placeholders for numbering that will be 
created once you send your document to the word processor. 

 

 

Note:  If you want to print the text in the any Progress window before 

you have answered all of the questions, you need to copy the text and 

paste it into a document in your word processor where you can print.  

To do so, place your cursor in the Progress window, choose Select All 
from the Edit menu. The text will be highlighted.  Then, select copy 

from the Edit menu.  Open your word processor and select paste. 

 

Repeat Questions: Certain sets of questions will be asked repeatedly to gather 

information about sets of people or situations. For example, you may need information 

for a client’s children; thus the questions soliciting this information need to be 

repeated for each child.   
 

The program addresses these situations with a unique type of question called a 

Repeat Question, which consists of a Repeat Control Question (See Figure 4-2 

below) and a series of substantive questions (e.g., name, birth date, gender) 

appropriate to the situation.  (See Figures 4-2 and 4-3 below).   Repeat Control 

Questions are identified on the Navigator by (Q REPEATS) to the right of the 
question and provide the following choices:  Add, Modify, Delete, Clear All 

Answers and Done. 
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Figure 4-2: 

Repeat Control 

Question 

  

 

 

  
  

 

 

 

The substantive questions follow the Repeat Control Question and are identified on the 

Navigator by a counter such as 1/2, where the right number indicates the total 

number of iterations and the left number indicates which iteration is currently on 
screen.  For example, 1/2 (see Figure 4-3 below) would indicate that there are two 

children and information about the first child is currently on screen. 

 

 

 

Figure 4-3: 
Repeat Question 
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Here's how the options mentioned above work: 

 

 If you were entering one of the couple's children, you would select Add at the 

Repeat Control Question (See Figure 4-2 above) and click Continue.  You would 
then be asked the substantive questions about that child (see Figure 4-3 above). 

When the sequence of questions is finished, you are returned to the Repeat Control 

Question. Select Add once again to provide information on an additional child. 

 

 To review and/or modify previously provided information or answers, select 

Modify at the Repeat Control Question and click Continue. Select the repeat 
element you would like to review and click OK.  This action takes you to the first 

question in the repeat sequence. You can then use the Navigator or the Review 

button (not the Continue button) to go directly to the answer at issue. 

 

After you have provided information for all of the children, select Done and click 

Continue to move on to the next series of questions. At any time you may return to a 
Repeat Control Question (look for "Q REPEATS" on the Navigator) to Add, Modify, or 

Delete an iteration (e.g., child). Deleting an iteration deletes all information for that 

person or situation. 

 

 

Changing Answers 

Once you have answered a question you can change your answer at any time.  There 

are two ways to do this: 

1. Click the PREVIOUS button:  This retraces your steps back through the exact 

sequence of questions you just answered, regardless of their numerical order.  (You 

can also click Previous on the Questions menu or press Ctrl+Up Arrow.)  It is best 

used the first time through the questions for a particular document.  The Previous 

button performs essentially the same function as the Back button on your Internet 

browser. 

2. Use the Navigator:  Scroll through the Navigator and click on the question whose 
answer you want to change.  The program will then take you to that question. Change 

your answer.  Then, click the CONTINUE button and the program will take you to the 

next unanswered question.  See the section titled Using the Navigator in Chapter 8: 

Navigating and Reviewing Your Answers for detailed information. 

 

Important!   Do NOT use the Navigator to answer questions for 

the first time.  You must use the Continue button to move through 
the Q&A in order to create your document.  The Navigator should 

be used to change and/or review questions that have already 

been answered. 
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Changing Answers in a Repeat Question 
 

Once you have answered a Repeat question, you might want to go back at a later time 

to add, modify or delete information.  To do this, you first need to locate the Repeat 

Control Question in the Navigator identified as (Q REPEATS) to the right of the 

question (See Figure 4-4 below).  Then, click on it and the program will take you to 
that question. 

 

 

 

Figure 4-4: 

Locating Repeat 
Control 

Questions on 

the Navigator 

  

 

 

  

 

 
 

Once at the Repeat Control Question, click Add, Modify, Delete or Clear All 

Answers, depending on what you want to do. Once you are done, simply click 

Continue to move to the next unanswered, relevant question. 

 
 

 

Note: You may review or edit the answers you have provided for 
an iteration of the Repeat Question by clicking Prev Repetition or 

Next Repetition on the Answers menu when in the Repeat 

Question.  This will move you sequentially through the answers.  

(See Figure 4-5 below), 
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Figure 4-5: 

Repetitions 

 

  

 

 

  

 

Printing the Navigator With or Without Your Answers 
 

You can send the Navigator’s questions with or without your answers by selecting 

Send on the File menu and then select Navigator Outline (See figure 4-6). Then 

choose either with or without your answers in the subsequent pop-up (see figure 4-7).  
A document named “Outline” is prepared and your word processor is opened (see 

figure 4-8).   

 

 

Figure 4-6: 

Navigator 

Outline 
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Figure 

4-7: 

Answers 
 

  

 

 

  

 

 

 

 

 

  

 

 

 

 

Figure 4-

8: 

Navigator 

Document 
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Chapter 5: Saving Your Answer Files 

 

 

There are two types of files that are created as part of your work: an answer file and a 

document file.   

 
The answer file consists of your answers (and notes) to the questions and is saved 

within the Lawgic program.  Typically you create one answer file per client.  All 

documents are then created from that one client answer file because answers are 

shared between documents, where appropriate. 

 

 

To save your answers select either: 
 

 Save (on the File menu), which saves your answers and notes under the existing 

file name (if a file name has already been created); or 

 

 Save As (on the File menu), which saves your answers and notes under a new file 

name.  It differs from Save in that it includes a Description dialog box where you 
can type in information on the file as well as a list of your client files.  You should 

chose this the first time you save an answer file. 

 

 

Important! You should save your answers immediately when 

you start a new answer file as well as periodically during the 

question and answer session. 

 

Should you forget to save your answers the AutoSave feature can help you recover 

some of your work. This feature automatically saves a separate copy of your answers 

to a file named “LGCTMP00.ANS” roughly every fifteen questions.  For more 

information, select Help from the Lawgic menu and then Help again.  Then, select 
Advanced Features and Recovering Your Work for detailed instructions on using 

this file. However, we recommend you do not rely on this feature. It is best to get in 

the habit of saving your answers as soon as you start a new answer file and 

periodically through the Q&A session. 

 

The document file is created at the end of the question and answer session by 

selecting Send Document to Word Processor when the ‘All Questions 
Answered’ dialog pops up. This will then open the document file in your word 

processor to be re-saved and edited as you would any fully formatted 

document. 
 

Transferring Answer Files Between Computers  
 

If you use the program both in your office and at home you can copy your answer files 

onto a flash drive, CD, attach to an email or other medium to transfer them to your 

home or laptop computer. 
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All answer files have an “.ans” extension and are stored in a sub-folder in the Lawgic 

folder on your computer. For instance, the Florida Wills & Trusts sub-folder is named 

‘fl_wt’ and is stored in the following path:  C:\Program Files (x86)\Lawgic\fl_wt.  

 

Using Answer Files as a Template  
 

Once you have completed an answer file and want to use it as a model set of answers 

or “template” for subsequent clients, you can create a Template.  This important, 

time-saving feature is explained in Chapter 9, Creating Templates.   

 

 

Important!   Once you have closed the program and want to 

return to your answer file at a later time, select File from the 
Select Title/File dialog box that appears when you first open 

Lawgic.  You can also get to the same Select Title/File box 

from within the Lawgic program by selecting File from the 

Lawgic menu and then Select Title/File, i.e. you do NOT need 

to close the Lawgic program to open another answer file. 
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Chapter 6:  Using the Notes and Tentative Features 

 

 

The program lets you record any thoughts or concerns you might have about certain 

questions. You can also mark questions for subsequent action or review. The 
information or marks you record are directly attached to the question(s) at issue, so 

that you don't have to rely on either memory or paper trails. Moreover, this 

information is easily shared with colleagues. 

 

Recording Your Thoughts with Notes 

 
Whenever you are on a question, you can click the Notes tab in the Folders Window 

and record observations you have about that question (see Figure 6-1). Your 
comments can be edited or deleted at any time. (Notes are part of your internal work 

product and do not form part of the document generated by the software.)  Questions 

containing Notes appear in green text on the Navigator 

 

Figure 6-1: 

Example of Notes 

  

 

 

  
  

 
Here are situations where you might like to create some Notes: 

 

 You are uncertain about a particular question and wish to record your concerns. 

 You are handing off your work to a colleague and want to bring his or her attention 

to particular issues. 

 You are creating or editing a template (model session) and want to record your 
insights on why you drafted the template the way you did. (Templates are 

discussed in Chapter 9.) 

 

 

Note: Notes are saved as part of your answer file. You can print your 

Notes by selecting the File from the menu, then Send and then click 

Notes. The program prepares a document named ‘Notes’ and sends it 

to your word processor.    
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Marking Questions as Tentative 

 
You can mark any question about which you are uncertain as 

"tentative." To do this, click the Tentative icon to the left of the 

PREVIOUS button while the question is on screen.   

 
Tentative questions appear in italics on the Navigator, and the Tentative icon 

changes appearance while such questions are on screen. After answering all of the 

questions, the program presents a ‘Tentative Answers’ dialog box that reminds you if 

any questions are marked "tentative."  You have three choices: 

 

 Review Tentative Answers Individually 
 Remove Tentative Status For All Answers 

 Ignore Tentative Status and Continue 

 

If you select ‘Review Tentative Answers Individually,’ the program automatically takes 

you to each of them in order. 

 
You can use the Tentative feature either separately or together with the Notes 

feature. 
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Chapter 7:  Creating Your Document 

 

 

In Chapter 3 we discussed the Progress folder, which allows you to preview the 

individual provisions of your document as it is being built. To finalize the document, 
you must answer all relevant questions until you get to the ‘All Questions Answered’ 

screen (see Figure 7-1).  Click Send Document to Word Processor.   

 

Figure 7-1: All 

Questions 

Answered dialog 

box 

  

 

 

  

  

 

   

The program will check your answers, create and name the document and open your 

word processor.    

 
Depending on your word processor you will either need to run the lawgic.wcm macro if 

using WordPerfect by selecting Tools/Macro/Play or you will need to generate the 

Table of Contents by selecting Control+A, then press Alt+Shift+U (or the F9 key) 

if using Word.  These instructions are typically found at the beginning of the 

document. 

 

 

Note: Once a document has been sent to Microsoft® Word, depending 

on your product, you will either get a "Lawgic will now format your 

document" message OR you will see the following message at the top 

of the document:  

Press Ctrl+A, to Select All, then press Alt+Shift+U (or the F9 

key) to complete the formatting of this document 

 
As an alternate to Alt+Shift+U or the F9 key, you can Right-click and 

select Update Field. 

 

 

With the document loaded in your word processor, you can review and edit 

the document.   
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Important!  Before editing your first document we highly 

recommend you review the Editing Your Documents topic for 

Word or WordPerfect available by selecting Help from the 

Lawgic menu and then Help again.  These topics provide step-
by-step instructions on how to add, move and delete 

provisions, and update the table of contents and cross-

references.   

 

 

Use the Save As… command on the word processor’s File menu, save the document 
under a new file name to a location where you typically store your client files.  

(You will notice that the document has been given a generic name, such as 

‘WTRIT00.doc’ for Revocable Intervivos Trust.)   Lawgic works with most document 

management systems 

 

 

 

Important!   If you just rename your document but do not 

move it to another location, the document will be saved in the 

default Docs subdirectory under the Lawgic directory.  If you 

forget to save the document under a new file name, the 

program will save it temporarily under a generic name with 

‘00’ at the end of the name, such as WTRIT00.doc; however, 

this file will be overwritten as you continue to generate additional 
documents. 

 

To create your next document:  Remember, one answer file creates multiple 

documents for your client, so to create your next document simply return to Lawgic 

and go to Question 1 (Select An Activity), select the next document (or 

activity), and answer the questions until you see the ‘All Questions Answered’ screen.  
Then, select Send Document to Word Processor to create the document. 

 

 

Changing Your Word Processor 

 
During installation, the program is usually able to identify your word processor 

automatically. However, if you have more than one word processor, change your word 

processors, or have installed to a non-standard word processor file path, you may 

need to specify the file path of the desired word processor either during installation or 
by clicking Set Preferences on the Edit menu and entering the file path in the Set 

Preferences dialog box (see Figure 7-2.) 

 

 

Figure 7-2: The 

word processor 
file path in the 

Set Preferences 

dialog box 
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If an incorrect path was identified during installation, there are two primary ways to 

determine the correct path:  the Browse utility on the Set Preferences dialog box 

(see Figure 7-2), or the Search/Find feature of your computer system. Once you 
have identified the file path, type it into the "Word Processor File Path" field on the 

Set Preferences dialog box. 

 

The path consists of the name of the executable file (.exe) for your word processor 

and the directory in which that file is located. The name of the executable file will 

depend on your word processor. 
 

The file path and executable files for several common word processors are: 

 

32-bit Word Processor paths 

 

Microsoft Word 2016  C:\Program Files (x86)\Microsoft 

Office\root\Office16\winword.exe 

Microsoft Word 2013 C:\Program Files (x86)\Microsoft 

Office\Office15\winword.exe 

Microsoft Word 2010 C:\Program Files (x86)\Microsoft 
Office\Office14\winword.exe 

Microsoft Word 2007 C:\Program Files (x86)\Microsoft 

Office\Office12\winword.exe 

Corel WordPerfect x7 C:\Program Files (x86)\Corel\WordPerfect Office 

X7\Programs\wpwin17.exe 

Corel WordPerfect x6 C:\Program Files (x86)\WordPerfect Office 

X6\Programs\wpwin16.exe 

Corel WordPerfect x5  C:\Program Files (x86)\WordPerfect Office 

X5\Programs \wpwin15.exe 

Corel WordPerfect x4 C:\Program Files (x86)\WordPerfect Office 

X4\Programs \wpwin14.exe 

Corel WordPerfect x3 C:\Program Files (x86)\WordPerfect Office 
X3\Programs\wpwin13.exe 

64-bit Word processor paths 

Microsoft Word 2016 C:\Program Files\Microsoft 

Office\root\Office16\winword.exe 

Microsoft Word 2013 C:\Program Files\Microsoft 

Office\Office15\winword.exe  

or  

C:\Program Files\Microsoft Office 15\Root\Office 

15\Winword.exe 

 

Example: C:\Program Files (x86)\Microsoft Office\Office15\winword.exe is a common 

file path for Word 2013. 
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Chapter 8:  Navigating and Reviewing Your Answers 

 

 

Now that you have created your first document you might want to go back to the 

answer file to review or change your answers.  The program has several features that 

simplify the review process to help you to navigate through the program. 
 

The Review Mode – Difference between Continue and Review 

 
While the Continue button takes you to the next relevant unanswered question, the 

Review button takes you to the next relevant question in sequence whether 

answered or not. 
 

 

To toggle between Continue and Review, click the arrow to 

the right of the Continue/Review button and select the 

desired mode. 

 

 

Here are simple rules on when to use Continue and when to use Review: 
 

 The Continue mode is the program default and it is the only correct way to 

move through the Q&A in order to create a document for the first time.  It 

takes you to unanswered relevant questions based on your prior answers. (You 

can also press Ctrl+Down Arrow on your keyboard to execute the 

Continue/Review function.) 
 

The Review mode is generally used once you have answered all of the questions and 

want to go back to the answer file at a later time to either review or change your 

answers.  You can click on any question in the Navigator and then switch to Review 

mode but remember to switch back to Continue mode if you want to send the 

document to the word processor. You will need to click Continue until you reach the 

’All Questions Answered’ box to do so. Keep in mind that using the Review mode is 
optional, i.e. you do NOT have to use Review to change your answers.  Rather, you 

can click any question in the Navigator to change your answer. 

 

 

 

Important!  If you are in Review mode and land on a Repeat 

Control Question, and want to Add an answer at that question, 
you need to temporarily switch back to the Continue mode first, 

add your answer and then switch back to Review mode to 

continue reviewing your answers. 

 

 

Note:  You can use the ‘sample’ or ‘law_surf’ answer files provided by 

Lawgic in conjunction with the Review button to change answers in order 
to view the text associated with different client fact patterns. These 

sample answer files are files where all questions have been answered. 



 33 

Chapter 9:  Creating Templates 

 

The ability to reuse previous work can be a great time-saver and ensure consistency 

and accuracy in your work output. The program has several features that let you 

reuse your work in helpful ways. 
 
Whenever you finish an answer file that you believe would make a good model for 
subsequent clients with a similar legal scenario, you should consider saving the file as 

a template. Basically, a template is a partial set of answers that you can reuse for 

subsequent clients.  You might consider creating a template to: 

 

 Ensure consistency in standard provisions 

 Create "masters" for recurring situations 
 Establish provisions favoring one side versus another 

 Customize answers for a client or an industry 

 

 

Note: Before saving an answer file as a template, consider adding 

Notes to certain questions to remind yourself and others of the 

template's use and of the decision-making reflected in it. 

 

Templates are created somewhat differently depending on the product. 

 

Creating Templates for Estate-Planning Products 
 

All estate-planning products have an automated template creation feature called the 
Template Assistant available by selecting Template Assistant from Question 1 

(Select Current Activity).   

 

The Template Assistant allows you to create a template from your current answer file 

by automatically clearing only client-specific answers, such as names, addresses, 

specific dispositions, etc.  It saves all other ‘fact-pattern’ answers, such as whether or 

not you create a bypass or QTIP trust, etc.   
 

When you go to use the Template, the program will only present the cleared ‘client-

specific’ answers and will skip over the pre-answered ‘fact-pattern’ ones.  This saves a 

tremendous amount of time.  Of course, you can change any answer that has been 

pre-answered or skipped. 

 
The Template Assistant feature also allows you to create a User Profile Template 

where you pre-answer questions relating to attorney information, drafting style, 

formatting and witnesses.  These are questions that you will want to answer the same 

way in every answer file you create. 

 

For instructions on how to use the Template Assistant, refer to the Question Help at 

the Template Assistant question as well as the Create Your Own Templates topic 
available by selecting How To at Question 1 (Select An Activity). 
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Creating Templates for California Family Law Products 

 

These products do not have an automated Template Assistant feature.  To 

create a template from a current answer file, do the following: 

 
 Open the answer file that you want to save as a template.   

 
 Select Save as Template on the File menu. This action displays the Save 

Template dialog box where you need to name your template.  You should also 

enter a description in the Description box. 

 

 Typically, you will only want to save some of the answers in your template, you 

can accomplish this by using flags.  After you have created and saved the 
template, you should flag those answers that you want to keep (or flag those you 

no longer want – whichever action requires the least amount of “flagging”).  Locate 

the questions you want to flag by using the Navigator and click the Flag icon. 

 

 It’s a good idea to save the flagged questions for future reference by selecting 

Save Flags from the Flag menu.  Then, name and save the flags.  You have now 

created a flag file. 
 

 Then, with the appropriate questions flagged, click Clear Multiple 

Answers/Notes on the Answers menu.  The dialog box that appears will ask you 

to indicate which answers you want to clear (i.e., “flagged” or “unflagged”).  To 

leave any notes, you might want to uncheck the ‘Flagged (or Unflagged) Notes’ 

box.  After you have cleared the answers you do NOT want to save, click OK. 
 

 Save the template again by clicking Save as Template on the File menu 

 

 

 

 

Important! For complex templates we suggest you 

schedule a free one on one training to guide you through 

the process the first time. 

 

 

 
 

 

 

 

 

 

 
 

http://www.lawgic.com/calendar.html


 35 

 

Using an Existing Template 
 

 

Note:   When you use a template as the basis for a new answer file, the 

new answer file is automatically given all information contained in the 

template, including answers and notes. 

 

 

There are several ways to load a Template, the simplest is to load a single template: 

 

 At the Select Title/File dialog box, select the desired Title and click Templates. 
This action displays a dialog box in which you select and load the template you 

wish to use into a New answer file which can then be saved. 

 

 Alternatively, from within an answer file, select Load Template on the Answers 

menu.  At the Select Title to Load a Template dialog box, select the Title whose 

template you would like to use (the default is your current Title) and click OK.  At 

the Load Template dialog box, select the template you would like to load and 
click OK. 

 

We also recommend you review the Using Templates topic in the general Help 

system by clicking Help on the Lawgic menu and then Help again. 
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COPYRIGHT NOTICE 
 

The software described in this publication is designed to provide accurate and 

authoritative information in regard to the subject matter covered. However, such 

information may not be sufficient in dealing with a client's particular legal problems, 
and Lawgic® LLC (“Lawgic”) does not warrant or represent its suitability for that 

purpose. The product is licensed with the understanding that Lawgic and its authors 

are not engaged in rendering legal, accounting, or other professional services. Under 

no circumstances should this product be used as a substitute for the proper retention 

of appropriate legal counsel, exercising his or her own professional judgment in 

representing the client, including research of original source material when 

appropriate. This product is not intended to be used in, or further, the unauthorized 
practice of law. 

 

Information has been obtained by Lawgic from authors and other sources believed to 

be reliable. However, because of the possibility of human or mechanical error, Lawgic 

does not guarantee the accuracy, adequacy, or completeness of any information and 

is not responsible for any errors or omissions or for the results obtained from the use 
of such information or this product. 

 

Copyright (c) 2016 Lawgic, LLC, a Florida limited liability company (“Lawgic”). All 

Rights Reserved.  Lawgic and Intelligent Legal Technology are registered trademarks 

of Lawgic, LLC. 

 
The software described in this publication is furnished under a license agreement. It is 

against the law to copy the software on any medium except as specifically allowed in 

the license agreement. No part of this publication may be reproduced or transmitted 

in any form or by any means, electronic or mechanical, for any purpose other than the 

purchaser's personal use, without the express written permission of Lawgic. 

 

USE OF THIS PRODUCT IS SUBJECT IN ALL RESPECTS TO THE LAWGIC LICENSE 
AGREEMENT FOR THIS PRODUCT. 

 

Windows© is a registered trademark of Microsoft corporation. 
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